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Abstract 

This document describes the hardware and software used to evaluate the DA9318 direct charging 
reference board. 
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1 Terms and Definitions 

GND Ground 

GUI Graphical User Interface 

IC Integrated Circuit 

JTAG Joint Test Action Group 

LED Light Emitting Diode 

LS Level Shifter 

OTG On-The-Go 

PC Personal Computer 

PD Power Delivery 

RCP Reverse Current Protection 

SAM3U  USB I2C Interface 

SCL Serial CLock 

SDA Serial DAta 

TA Travel Adaptor 

USB Universal Serial Bus 

2 References 

[1] DA9318 Datasheet, Dialog Semiconductor 

[2] 329-03-D_ SCH.pdf, Dialog Semiconductor 

[3] DA9318_Direct_Charging_Rev2.2.pdf, Dialog Semiconductor (under NDA) 
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3 Introduction 

The purpose of the reference board is to demonstrate DA9318 in a direct charging application.  

The document covers a normal charging cycle, using an off-the-shelf charger IC and a charging cycle 
with the direct charging enabled. Direct charging means connecting the travel adaptor (TA) directly to 
the battery in the constant current charging phase. A block diagram of the DA9318 direct charging 
reference board is shown in Figure 1. 

 

DA9318 Direct Charging Reference Board

DA9318

T
y
p

e
-C

 R
e

c
e

p
ta

c
le

VBUS

Main Charger

SYS

Atmel

SAM3UD+

D-

VBUS

GND

SYS

BAT

M
in

i-
B

R
e

c
e

p
ta

c
le

SW

BAT

IN

IN OUT

SCL

SDA

GPIO

LP3871
3V3

Travel

Adaptor

Battery

Emulator

Load

nCE

nCE

nPG

STAT

nCPEN

nCPEN

SYS

ILIM

IUSB[2:0]

ILIM

GND

INA219

IN+ IN-

VS
SCL

SDA
VBAT

GND

GND

Load Transient

nPG

nCHG

Power

Supply

PGND

PMID

SCL

SDA

BOOT

3V3

I2C

FAN25

58

VDD_IO (3V3)

VDD_IO
+5V_USB

+5V_USB

OTG

nQON

GND

VBUS

CON

VBUS

SYS

TPD1S514

J37

RS

10 mΩ

INA219

IN+ IN-

VS
SCL

SDA
VIN

RS

10 mΩ

CC1

CC2

TPS65982

SCL

SDA

CC1

CC2

VBUS

J64

OVP_OUT

OVP_OUT VDD_IO

VDD_IO & 

VIN_3V3

Flash IC

SPI

Line Transient

VIN

VBAT

 

Figure 1: DA9318 Direct Charging Block Diagram 

The DA9318 direct charging reference board, see Figure 2, facilitates the measurement, evaluation, 
and configuration of a battery charging cycle when connected to a TA that includes the iW1781 
primary side controller, iW676 secondary side controller and iW656 USB PD interface controller chip 
set. 

Dialog’s software package SmartCanvas™ uses a simple graphical user interface which enables 
DA9318 to be controlled via the USB port of a PC. The mini USB connection is visible on the left side 
of the board. When the cable is connected to the USB port of the PC the green LED (D3) is on. 

The board contains jumper links, see Figure 6, to provide access to alternative configurations and 
measurement test points. Most standard operating modes are evaluated with minimal link changes. 



 

 

UM-PM-022 

  

 

DA9318 Direct Charging Reference Board  

User Manual Revision 3.2 16-Feb-2022 

CFR0012 5 of 39 © 2022 Renesas Electronics 

 

Figure 2: DA9318 Direct Charging Reference Board (329-03-D) 
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4 Functional Description 

During direct charging the main charger of the battery operated device is bypassed and the Dialog 
TA is directly connected to the battery.  

The difference between normal charging and direct charging is illustrated in Figure 3.  

In order for the direct charging to work, the TA has to have a configurable output voltage and current 
limit. Currently the Dialog’s 33 W TA can support output voltages of between 3.3 V and 11 V in 25 
mV steps, and current limits up to 3 A in 50 mA steps. 
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Figure 3: Normal Charging (Top) and Direct Charging (Bottom) 

4.1 Main Charger 

The main charger is capable of handling a complete charging cycle without host interaction. 

The input current limit is set via GPIOs and the charging current and dynamic power management 
thresholds are set with external pull-down resistors.  
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The charging statuses are communicated via LEDs. The main charger can be enabled with the nCE 
signal driven from the microcontroller. During direct charging the main charger is disabled.  
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4.2 Power Monitor 

Two power monitor ICs (INA226), fitted on the DA9318 direct charging reference board, allow for 
measurement of the main charger input voltage and input current, and for monitoring the battery 
current and voltage.  

That information is read out via the I2C interface and used in the control GUI software running on the 
PC.  

When direct charging is enabled, the DA9318 internal ADC is monitoring the input/output current and 
input/output voltage.  

Power monitoring is a safety feature associated with direct charging. The input power of the mobile 
device has to be compared to the output power of the TA. A mismatch indicates a fault condition and 
the charging has to be terminated.  

4.3 Direct Charging 

Reverse current protection (RCP) is enabled whenever DA9318 is not in the ACTIVE mode. 

DA9318 is capable of starting up when VIN is within the accepted range defined by VIN2OUT_MIN and 
VIN2OUT_MAX. If VIN is not within the accepted range during start-up, the start-up is aborted. 

When the above conditions are satisfied the DA9318 can be enabled by writing CP_EN to allow for 
direct charging. The TA voltage is set accordingly to allow the pre-defined charge current into the 
battery. 

During direct charging the main charger is disabled. 

4.4 Over-Voltage Protection 

Over-voltage protection (OVP) is needed for general protection of devices connected to VBUS.  

TI TPD1S514, Fairchild FPF2280, and Kinetic KTS1682 can be used as they all are pinout 
compatible parts with very similar feature sets. 

 

 

  

http://www.ti.com/lit/ds/symlink/tpd1s514.pdf
https://www.fairchildsemi.com/datasheets/FP/FPF2280.pdf
http://www.kinet-ic.com/pro_detail.php?id/76.htm
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4.5 Direct Charging Sequence 

A sequence diagram for direct charging is depicted in Figure 4. 

NOTE 

The DA9318 direct charging reference board communication to the TA is achieved using USB PD 
communication protocol. The sequence diagram in Figure 4 is provided for information only. Please contact ic-

support@diasemi.com for more information. 

 

DA9318TA Main Charger

Read (VBAT)
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PC
Power 
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TA 

Control
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Read VBAT

Configure target VBUS 
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TA Control exchange power capabilities and 

request to make a first contract. TA identity 

checked and VDM communication initiated.

Set (VBUS)

Done

Read (VBUS)
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target value, direct 

charging is continued

nCE=’1'

CP_EN=’1'

loop

Read (IIN)

Direct charging begins

Read (VBUS)

Write (TARG_VBUS)

Write (TARG_ILIM)

As VBAT rises the output voltage of the 

TA is increased. After the target VBAT 

is hit the current limit of the TA is step-

wise reduced

Set (VBUS)
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Direct charging ends
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The main charger 
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TA connected

 

Figure 4: Sequence Diagram for Direct Charging  

mailto:ic-support@diasemi.com
mailto:ic-support@diasemi.com
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5 DA9318 Direct Charging Reference Board Hardware 

The DA9318 direct charging reference board functionality can be broken down into sections, see 
Figure 5: 

● USB Type-C™ cable input, OVP switch, input connector. 

● Main charger / ADCs. 

● DA9318 direct charging. 

● USB PD. 

● USB interface (I2C communication) and USB reset. 

● Voltage monitoring connectors and IOs. 

● Battery and system connectors. 

 

Figure 5: Functional Sections 
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5.1 Default Link Positions and Connector Definitions 

 

Figure 6: Default Link Positions 

Table 1: Default Link Positions and Connector Definitions 

Reference Designator Position Function 

J1 NA USB-C inlet 

J2 NA SMA connector for measuring IN 

J3 NA SMA connector for measuring C1P 

J4 NA Line transient connector 

J5 
1 IN sense point 

2 GND sense point 

J6 NA SMA connector for measuring C1N (labeled as C1M) 

J7 NA SMA connector for measuring OUT 

J8 NA OUT connector 

J9 
1-2, 3-4, 5-6 
(Close) 

IN connector shunt to IN of DA9318 

J10 
1 SYS sense point 

2 GND sense point 

J11 NA OUT connector 
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Reference Designator Position Function 

J12 NA IN connector 

J13 NA IN connector 

J15 
Close (Default) Short VOUT_DA9318 to VBATP for a local pack sensing 

Open VOUT_DA9318 and VBATP disconnected to allow cell sensing 

J16 NA VBATP connector for cell sensing 

J17 
1-2 (Close) 

DA9318 input disconnect 
3-4 (Close) 

J18 
Close (Default) Short GND to VBATN for a local pack sensing 

Open GND and VBATN disconnected to allow cell sensing 

J19 NA VBATN connector for cell sensing 

J20 NA GND connector (IN side of board) 

J21 NA GND connector (IN side of board) 

J22 1-2 (Open) Main charger PGB GPIO connection to SAM3U 

J23 
1-2  

Main charger PSEL settings 
2-3 (Close) 

J24 NA GND connector (OUT side of board) 

J25 NA GND connector (OUT side of board) 

J26 1-2 (Close) Main charger Current Limit settings 

J29 
1-2 (Close) 

Main charger thermistor connection 
2-3 

J30 1-2 (Open) Main charger thermistor sensor short to ground  

J31 NA SMA connector for measuring SYS 

J32 NA JTAG: reserved 

J33 NA SMA connector for measuring C2N (labeled as C2M) 

J34 1-2 (Open) Important: This erases the USB IC firmware. DO NOT SHORT 

J37 NA Load transient connector 

J38 NA SYS connector 

J39 

1-2 (Close) SCL from SAM3U connected to DA9318 

3-4 (Close) SDA from SAM3U connected to DA9318 

5-6 (Close) SCL from SAM3U connected to USB PD IC 

7-8 (Close) SDA from SAM3U connected to USB PD IC 

J41 NA SMA connector for measuring C2P 

J44 1-2 (Close) Main charger Status read connection to Atmel 

J45 1-2 (Close) INTB GPIO connection to SAM3U 

J46 1-2 (Close) OTG to Ground 

J47 1-2 (Close) Main charger enable through GPIO 

J48 1-2 (Close) Main charger enable 

J49 
1-2 (Close) Both sides of level shifter set to VDD_IO 

2-3 Level shift from AVDD to VDD_IO 
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Reference Designator Position Function 

J50 
1-2 (Close) Both sides of level shifter set to VDD_IO 

2-3 Level shift from AVDD to VDD_IO 

J55 
1-2 (Close) nFAULT pulled up to rail selected by J56 

2-3 nFAULT pulled to ground 

J56 
1-2 (Close) nFAULT PU selection: VDD_IO 

2-3 nFAULT PU selection: AVDD 

J57 
1-2 (Close) nIRQ pulled up to rail selected by J58 

2-3 nIRQ pulled to ground 

J58 
1-2 (Close) nIRQ PU selection: VDD_IO 

2-3 nIRQ PU selection: AVDD 

J59 NA Measurement header 

J60 NA USB inlet 

J61 

1-2 (Close) nIRQ connected to level shifter and SAM3U 

3-4 (Close) nFAULT connected to level shifter and SAM3U 

5-6 (Close) CC1 connected to level shifter and SAM3U 

7-8 (Close) CC2 connected to level shifter and SAM3U 

9-10 (Close) PWREN connected to level shifter and SAM3U 

11-12 (Close) nCPEN connected to level shifter and SAM3U 

J62 
1-2 (Close) 

PWREN sorted to AVDD (options available for connection to +5V or 
SYS) 

2-3 PWREN shorted to GND to enter NO-POWER mode 

J63 
1-2 (Close) nCPEN shorted to AVDD 

2-3 nCPEN shorted to GND 

S1 NA Main charger ON switch  

S2 NA USB PD HRESET switch 

S3 NA Push button to reset the USB IC 
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5.2 USB Interface 

The DA9318 direct charging board uses an ATMEL® SAM3U® microcontroller as the USB 
transceiver, programmed to deliver the following functionalities: 

● I2C control interfaces. 

● Discrete digital IO control (General Purpose Input Output (GPIO) and dedicated functions). 

5.2.1 USB Power and GUI Reset 

The USB is powered by an on-board regulator (VR2), see Figure 7. Pressing the USB RESET switch 
S3 shuts down the on-board regulator VR2, powering down the supply for the SAM3U (USB I2C 
interface). This resets the GUI communication with the reference board. 

  

Figure 7: USB Interface Connector and Reset Switch 

Table 2: Power Configuration Switch 

Switch Name Reference 
Designator 

Type Function 

USB RESET S3 Push 
button 

Shuts down the on-board regulator that generates the 
interface supply 

5.3 Power Supplies 

The DA9318 direct charging board is powered up when a power source is connected to IN (J12). IN 
operating voltage range is +5.5 V to +10.5 V. 

● The VDD_IO voltage is generated by an on-board regulator (VR1) supplied from the +5 V USB. 
By default, the on-board generated VDD_IO is +3.3 V. 

NOTE 

For correct operation, connect the reference board to a USB port capable of supplying 500 mA. 
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6 DA9318 Direct Charging Reference Board Software 

The board is controlled using a graphical user interface (GUI), which requires a PC operating 
Windows® 2000/XP/Vista/Windows 7 with a USB1.1 or USB2 interface. The GUI allows the user to: 

● Perform raw write and read operations to all control registers on Dialog and non-Dialog ICs. 

● Monitor the charging status. 

● Plot the DA9318 efficiency over time with saving and zoom feature. 

● Plot the main charger efficiency over time with saving and zoom feature. 

● Plot the DA9318 temperature over time with saving and zoom feature. 

● Poll the DA9318 registers. 

● Read ADC data from DA9318 (VIN, VBAT, IIN, IOUT and TJUNC) when the DA9318 is enabled. 

● Read ADC data from external ADC ICs (VIN, VBAT, IIN and IOUT) when the main charger is enabled. 

● Control the TA voltage and current limit via the USB PD protocol; and main charger voltage 
termination, charge current and current limit. 

● Send default settings. 

● Read all registers displayed. 

● Clear faults. 

6.1 GUI Installation 

The files required to install the software are available on the supplied USB drive. To install the 
DA9318 reference board software: 

1. Run setup_DA9318_Reference_GUI.x.x.x.xx.exe. 

2. On completion, insert the USB cable and apply VIN.  

a. For first time users Windows should detect the attached USB device. If this is not the case, it 
may be necessary to install the driver by navigating to the required driver file in the USB 
driver directory, see section 6.2. After installing the driver, reboot the PC to ensure correct 
operation.  

3. Start the software by running DA9318 Reference GUI.exe. 
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6.1.1 GUI Installation Step By Step Guide 

 

Figure 8: GUI Setup License Agreement 

1. Select I accept the agreement then click Next. 
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Figure 9: GUI Setup Destination Location 

2. Click Next. 

 

Figure 10: GUI Setup Start Menu Location 
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3. Click Next. 

 

Figure 11: GUI Setup Additional Tasks 

4. Select the Create a desktop shortcut check box (if required) and click Next. 
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Figure 12: GUI Setup Start Installation 

5. Click Install. 

 

Figure 13: GUI Setup Finish and Launch 
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6. Click Finish. 

 

Once the installation is completed, you may need to restart your computer.  

When the software is installed, insert the USB cable before applying VSYS and VIN. The DA9318 
SmartCanvas software can be started after power up. 

6.2 Initial USB Connection 

On connecting the USB to the PC for the first time, the SAM3U USB driver will request driver 
updating/installation from the Windows operating system. On Windows 7 (32-bit) operating systems 
(OS) the driver usually installs automatically. On Windows 7 (64-bit) machines it is common for the 
complete driver installation to fail. If this happens, install the driver manually by following these steps: 

1. Control Panel → Devices and Printers (double-click device with yellow exclamation sign). 

2. Update Driver. 

3. Browse my computer for driver software. 

4. Select the Driver folder location: C:\Dialog Semiconductor\Power Management\DA9318 
Reference GUI\Driver. 

5. If Windows warns about the driver, select Install anyway. 

6. Remove the USB cable and then re-insert it into the reference board. 
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7 GUI Software 

Run the DA9318 Reference Board GUI software by clicking the shortcut on the appropriate item in 
the Start menu (All Programs → Dialog Semiconductor → Power Management → DA9318 
Reference GUI). The screen shown in Figure 14 is displayed. 

The minimum recommended setting for the PC display size is 1024x768 pixels. Font size on the PC 
display should be Normal (95 dpi).  

NOTE 

A display size other than the recommended setting will affect the way in which the panels appear. 

7.1 Controls 

Figure 14 shows the main GUI interface. 

 

 

Figure 14: Main GUI Interface 
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7.2 Control Widgets 

7.2.1 Enable/Disable Polling 

The polling switch enables or disables polling of the device registers and the refreshing of the 
registers’ controls on the GUI interface. 

 

Figure 15: Polling 

7.2.2 Charging Status Indicators 

The Status Indicators window, see Error! Reference source not found., displays the following 
information: 

● Pre-Charge: When the battery voltage is below 3 V (VBATLOW), the battery is pre-charged at a 
lower charge current of 128 mA. 

● Constant-Current: When the battery voltage is above 3 V and below the constant voltage 
threshold; this indicator will light green. This indictor will also light green in conjunction with the 
Direct Charging indicator during direct charger. 

● Constant-Voltage: When the battery voltage reaches the main charger constant voltage 
termination voltage threshold, this indicator will light green indicating charger is in constant 
voltage. 

● Direct Charging: This indicator will light green when the direct charger (DA9318) is enabled. 

● DONE: This indicator will light green when charge cycle is complete. 

 

Figure 16: Charging Status Indicators 

The update actions are as follows: 

● Read All Registers – even if the hardware device is not being actively polled then all the 
registers can be polled once by pressing this button. 

 

Figure 17: Read All Regs Button 
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7.2.3 Charge Status Indicators 

The GUI indicates the following charge statuses (assuming that the TA and the battery are both 
connected).  

“State = SUSPENDED” means that the Polling is off.  

  

Figure 18: State = SUSPENDED 

 

“State = IDLE_CHARGE” means that the Polling is on; the Main Charger and the Direct Charger 
are off. 

 

Figure 19: State = IDLE_CHARGE 

 

“State = MAIN_CHARGER” means that the Polling is on; the Main Charger is on and the Direct 
Charger is off. Auto Charge is off. 

The Status Indicators window displays the following charge status: Pre-Charge, Constant-Current, 
Constant-Voltage, Direct Charging and DONE. 

 

Figure 20: State = MAIN_CHARGER 

 

“State = ONE_SHOT_DIRECT_CHARGE” means that the Polling is on; the Main Charger is off 
and the Direct Charger is off. Auto Charge is off. 

The Status Indicators window displays the following charge status: Pre-Charge, Constant-Current, 
Constant-Voltage, Direct Charging and DONE. 

 

Figure 21: State = ONE_SHOT_DIRECT_CHARGE 
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State = AUTO_CHARGE and Auto State = MAIN_CHARGING means that the Polling is on; the 
Auto Charge is set, the Main Charger is on and the Direct Charger is off. 

The Status Indicators window displays the following charge status: Pre-Charge, Constant-Current, 
Constant-Voltage, Direct Charging and DONE. 

 

Figure 22: State = AUTO_CHARGE and Auto State = MAIN_CHARGING 

 

State = AUTO_CHARGE and Auto State = DIRECT_CHARGING means that the Polling is on; the 
Auto Charge is set, the Main Charger is off and the Direct Charger is on. 

The Status Indicators window displays the following charge status: Pre-Charge, Constant-Current, 
Constant-Voltage, Direct Charging and DONE. 

 

Figure 23: State = AUTO_CHARGE and Auto State = DIRECT_CHARGING 

 

State = AUTO_CHARGE and Auto State =END_OF_CHARGE means that the Polling is on; the 
Auto Charge is set, the Main Charger is on and the Direct Charger is off. 

The Status Indicators window displays the following charge status: Pre-Charge, Constant-Current, 
Constant-Voltage, Direct Charging and DONE. 

  

Figure 24: State = AUTO_CHARGE and Auto State = END_OF_CHARGE   
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7.2.4 Raw I/O 

The Raw I/O control sends the entered device address, register address and data on the I2C 
communications interface. If the information sent is not valid then the I2C message will return NACK 
an error message will be displayed in the Status window. 

   

Figure 25: Raw I/O 

7.2.5 Interface Control Information 

In the View menu, click on Status, the Status window is displayed. 

In the Status window, select the Log tab and Log Level: Info. This will display interface control 
information including: name, parent register and the bits to which this control corresponds, current 
value, whether it is read-only or R/W access, and finally a description of each possible setting. 

 

Figure 26: Interface Control Information 

7.2.6 I2C Bus Scan 

In the Tools menu, click on Scan I2C, the I2C Bus Scan window is displayed. 

In the I2C Bus Scan window, selected Scan. Once the scan has completed, all I2C slave addresses 
will be displayed.  
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Figure 27: I2C Bus Scan 

7.2.7 Settings 

In the Options menu, click on Settings, the Settings window is displayed. 

The Auto Charging parameters can be configured in the Settings window. 

 

 

Figure 28: Settings – Auto Charging 
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7.3 Quick Start Guide 

7.3.1 Manual Charge Operation 

The recommended steps to manually operate the DA9318 direct charging reference board are shown 
below. 

Main Charger

DA9318
Direct Charger

Overvoltage 
Protection IC

Travel 
Adaptor (TA) CC1/CC2

VBUS

SYS

BATT

BATT

 

 

Figure 29: Test Setup (329-03-C board revision shown) 



 

 

UM-PM-022 

  

 

DA9318 Direct Charging Reference Board  

User Manual Revision 3.2 16-Feb-2022 

CFR0012 28 of 39 © 2022 Renesas Electronics 

 

 

Figure 30: GUI Configuration – Manual Charge Operation 

7.3.1.1 Operational Steps 

The following operational steps assume that a battery is inserted initially and then the TA is inserted 
to J1. In addition, J60 must be connected to the USB port of a computer for I2C communication using 
the DA9318 Reference Board SmartCanvas GUI software. 

NOTE 

The battery voltage should be set to 3.1 V to allow for a 4 A initial target charge current when direct charging is 

enabled. 

The button or status indicator locations for each operational step are highlighted in Figure 30: 

1. Click the Read All button, to read all registers to their current states. 

2. Click the No Events button, to clear any events. 

3. Click the Main Charger button. The Constant-Current status indicator flags green, signaling that 
the main charger is enabled. 

4. Enable the Direct Charger switch (the Main Charger button auto disables). Direct charging is 
enabled via DA9318 and the Constant- Current and Direct Charging status indicators flag 
green.  

NOTE 

The direct charger current can then be increased up to 6 A by first increasing the TA CC Setting to no more 
than 3 A; and then by increasing the TA V Setting until the targeted direct charger current is reached and the 

TA operates in current limit. 

5. When the Constant-Voltage status indicator flag is green, step down the TA CC Setting by 
100 mA steps (or greater initially) until the minimum value is reached (400 mA). Note that for 
each step the Constant-Voltage status indicator will alternately flag red and green as the battery 
charges up.  

1 

2 

3 

4&6 
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6. When the TA CC Setting has reached the minimum value, disable the Direct Charger switch to 
return to main charger until the DONE status indicator flags green, signaling the end of the 
charge cycle. 

NOTE 

Unless the watchdog timer is serviced, it is recommended to disable it by disabling the Chgr Watchdog switch 

while the main charger is enabled.  

This is to ensure that the main charger does not initiate a power-on-reset when the watchdog timer has expired. 
Indeed, when the watchdog timer has expired, the device returns to default mode and all registers are reset to 

default values.  

When highlighted, clicking on the Clear Events switch clears all DA9318 events. When no events are flagged 

the switch indicates No Events. 
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7.3.2 Automatic Charge Operation 

An overview of the different charging phases is illustrated in Figure 31.   

VBAT

IBAT

Constant voltageDirect chargingPre-charge

VBATT_WARN

V
B

A
T

Constant current

DA9318

Main Charger

Time

Time

 

Figure 31: Overview of the Entire Charging Cycle 

The recommended steps to initiate an automatic charge cycle using the DA9318 direct charging 
reference board are shown below. 
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7.3.2.1 Customer Configuration 

In the Options menu, click on Settings, the Settings window is displayed. 

1. Select the VBat Main to Direct Charger handover thresholds (volts) voltage. This is the 
battery voltage threshold to automatically enable the direct charger. The default value is 3.3 V. 

2. Select the IBat Direct to Main Charger handover threshold (amps) current. This is the battery 
current threshold to automatically switch from direct charging to main charging. The default value 
is 0.9 A. 

3. Select the Battery step down current step (mA) current. This is the battery current step during 
the ramp down of the travel adaptor current limit. The default value is 100 mA. 

4. Select the Direct Charger VBat Warning Threshold (volts) voltage. This is the battery voltage 
threshold for the assertion of the E_VBAT_WARN event, hence the start of the of the travel 
adaptor current limit reduction. The default value is 4.351339286 V that is 99 % of the Main CV 
targeted end-of-charge voltage (Main CV = 4.400 V by default).  

In the case of a 4.2 V battery being used, Direct Charger VBat Warning Threshold (volts) 
must be set to ~99 % x 4.2 V (use the nearer value available in the drop down combo box) and 
Main CV must be set to 4.200 V. 

NOTE 

If any of the parameters are changed from their default settings, then click on the Save at start-up button and 

restart the GUI. 

 

 

Figure 32: Settings – Auto Charging 
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7.3.2.2 Operational Steps 

To initiate an automatic charge cycle, one assumes that a fully discharged battery (VBAT < 2.8 V) is 
inserted.  

Also the TA needs to be inserted to J1 – there is no order in which the battery or TA needs to be 
inserted first.  

In addition, J60 must be connected to the USB port of a computer for I2C communication using the 
DA9318 Reference Board SmartCanvas GUI software. 

NOTE 

Reference Designator Position Function 

J15 
Close Short VOUT_DA9318 to VBATP for a local pack sensing 

Open VOUT_DA9318 and VBATP disconnected to allow cell sensing 

J16 NA VBATP connector for cell sensing 

J18 
Close  Short GND to VBATN for a local pack sensing 

Open GND and VBATN disconnected to allow cell sensing 

J19 NA VBATN connector for cell sensing 

Both jumpers on J15 and J18 must not be fitted. The battery +/- senses must be connected to J16 (+ sense) and 
J19 (- sense). 

The steps to operate the automatic charge cycle are highlighted in Figure 33: 

1. Check out the battery charge voltage (see battery information) and set the Main CV accordingly.  

2. As required, check out and modify the Auto Charging parameters in the Options → Settings 
window – see paragraph 7.3.2.1. 

3. Click the Auto Charge button, to start the automatic charge cycle. 

The charge cycle (i.e. plotting the battery voltage and charge current) is shown by the Profile Plot of 
the Real-time Charging Performance Graphs.  

The main charger and DA9318 efficiency is shown by the Efficiency Plot; whereas the DA9318 die 
temperature is shown by the Temperature Plot.  

 

Figure 33: GUI Configuration – Automatic Charge Operation  
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NOTE 

The target charge current can be increased or decreased by setting the new target in the Target Battery 

Current field prior to enabling the Auto Charge.  

When the Auto Charge is set the settings cannot be changed on the fly. All changes made to any settings will 

be ignored until a new charge is initiated. 

 

7.3.2.3  Charge Cycles Examples  

Example #1: 3.7 V 11560 mAH/43 Wh Tablet Battery 

Figure 34 shows the automatic charge cycle of a 3.7 V 11560 mAH/43 Wh tablet battery.  

 

Figure 34: Automatic Charge Cycle – Profile Plot – 11560 mAh Battery 

The test conditions are shown here below: 

• Main CC = 2.048 A 

• Main CV = 4.208 V 

• Target Battery Current = 5.000 A 

• VBat Main to Direct Charger handover thresholds (volts) = 3.3 V 

• IBat Direct to Main Charger handover threshold (amps) = 1.1 A 

• Battery step down current step (mA) = 100 mA 

• Direct Charger VBat Warning Threshold (volts) = 4.157589286 V 

 

NOTE 

In Auto Mode the Target Battery Current for the 11560 mAh battery can be set to 5.500 A maximum.   

 

Initially the main charger is in pre-charge (128 mA by default) until the battery voltage reaches 3 V 
(default threshold set in the main charger’s registers).  

Then, the main charger enters fast charge with a fast charge current arbitrarily set to 1.024 A.  

Once the handover battery voltage threshold is reached to enter direct charging; the main charger is 
disabled and the DA9318 is enabled with a target battery charge current of 5.5 A. 

Upon assertion of the E_VBAT_WARN event, the TA current is reduced allowing for a smaller 
charge current; then the E_VBAT_WARN event is reset.  

Every time the E_VBAT_WARN event is flagged up the TA steps down its current limit setting 
accordingly by yet another current step.  



 

 

UM-PM-022 

  

 

DA9318 Direct Charging Reference Board  

User Manual Revision 3.2 16-Feb-2022 

CFR0012 34 of 39 © 2022 Renesas Electronics 

When the charge current reaches a handover charge current threshold (arbitrarily set to 0.9 A) the 
DA9318 is switched off and the main charger is enabled and finishes off the charge cycle.  

The main charger continues its fast charge and voltage regulation phase until the termination current 
is reach where the main charger will get disabled. 

 

 

Figure 35: Automatic Charge Cycle – Efficiency Plot – 11560 mAh Battery 

 

 
Figure 36: Automatic Charge Cycle – Temperature Plot – 11560 mAh Battery 
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Example #2: 3.7 V 3600 mAH/13.86 Wh Mobile Phone Battery 

Figure 37 shows the automatic charge cycle of a 3.7 V 3600 mAH/13.86 Wh mobile phone battery.  

 

Figure 37: Automatic Charge Cycle – Profile Plot – 3600 mAh Battery 

The test conditions are shown here below: 

• Main CC = 1.024 A 

• Main CV = 4.400 V 

• Target Battery Current = 4.500 A 

• VBat Main to Direct Charger handover thresholds (volts) = 3.3 V 

• IBat Direct to Main Charger handover threshold (amps) = 0.9 A 

• Battery step down current step (mA) = 100 mA 

• Direct Charger VBat Warning Threshold (volts) = 4.351339286 V 

 

NOTE 

In Auto Mode the Target Battery Current for the 3600 mAh battery can be set to 5.000 A maximum.   
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Figure 38: Automatic Charge Cycle – Efficiency Plot – 3600 mAh Battery 

 

 
Figure 39: Automatic Charge Cycle – Temperature Plot – 3600 mAh Battery 
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Revision History 

Revision Date Description 

1.0 01-Mar-2017 Initial version. 

2.0 19-Jul-2017 USP PD implemented. New 329-03-C board and GUI. 

3.0 28-Nov-2017 Added automatic charge cycle section. 

3.1 23-Jul-2018 Main charger changed to Halo Micro’s HL7018. Board revision changed 

to 329-03-D. 

3.2 16-Feb-2022 Document rebranded to Renesas. 
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Status Definitions 

Status Definition 

DRAFT The content of this document is under review and subject to formal approval, which may result in modifications or 

additions.  

APPROVED 

or unmarked 

The content of this document has been approved for publication.  
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